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Inleiding

U hebt de keuze gemaakt te gaan werken met AutoCAD of AutoCAD LT. Auto-
CAD is een van de meest gebruikte technische tekenprogramma’s. Het is een
uitgebreid en soms complex programma, maar als u de basis eenmaal onder
de knie hebt, zult u ervaren dat u vrij snel aan tekenen toekomt. Niet voor niets
heeft AutoCAD miljoenen gebruikers wereldwijd.

Een groot deel van de complexiteit van AutoCAD is toe te schrijven aan de his-
torie van het programma. In 1982 zag de eerste versie van AutoCAD het licht.
Dit was in een DOS-periode waarin Windows nog ontwikkeld moest worden.
Pas bij versie 13 in 1994 werd AutoCAD geschikt om onder Windows te werken.
Hiermee kwamen de werkbalken en meer dialoogvensters ter beschikking. Met
de komst van Microsoft Windows Vista en Office 2007 zijn opnieuw verschillen-
de gebruikersinterfaceopties aan Windows toegevoegd. AutoCAD is volledig
geoptimaliseerd om met Windows samen te werken. Sinds 2010 is AutoCAD
ook te verkrijgen voor de Mac. Hoewel de basishandelingen sterk op elkaar lij-
ken, beschrijft dit boek specifiek de Windows-variant van AutoCAD.

Met de huidige AutoCAD-versie is het nog steeds mogelijk om te tekenen alsof
we met een oude DOS-computer uit 1982 werken. De programmeurs van Auto-
desk breiden het programma namelijk steeds verder uit en verwijderen slechts
af en toe ‘oude’ functionaliteiten. Hierdoor is het spreekwoord ‘Er leiden meer-
dere wegen naar Rome’ zeker op AutoCAD van toepassing. Voor de beginnende
tekenaar kan dit soms verwarrend zijn, terwijl de gevorderde tekenaar kan kie-
zen uit een uitgebreid scala aan mogelijkheden en commando’s. De gebruiks-
vriendelijkheid is dus afhankelijk van aan wie u het vraagt.

Verschillen tussen AutoCAD en AutoCAD LT
AutoCAD is de volledige uitgebreide versie van het programma. Dit bevat naast
alle teken- en bewerkingsfuncties onder meer ook functies voor:

e 3D-tekenen;
¢ diverse geavanceerde beheerderfuncties;
¢ mogelijkheden te programmeren binnen het programma.
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AutoCAD LT bevat sommige van deze functies in beperkte mate, en andere
functies helemaal niet. De ware vertaling van LT is enigszins onduidelijk. LT
wordt in de volksmond dan ook vertaald als ‘LighT’, maar is waarschijnlijk een
afkorting van ‘Low Technology’ wat staat voor ‘verminderde technologie’. Met
andere woorden: AutoCAD LT is een uitgeklede versie van AutoCAD die in eer-
ste instantie was bedoeld voor gebruik op een laptop.

Demanier van werken van beide programma’sis echter identiek en 2D-tekenin-
genvan hetene programma kunnen worden geopend en bewerktin hetandere.
3D-tekeningen van AutoCAD kunnen wel worden geopend in AutoCAD LT,
maar kunnen slechts beperkt worden bewerkt. Alle uitleg en oefeningen in dit
boek zijn gebaseerd op een standaardinstallatie van AutoCAD. Daar waar er
verschillen zijn met AutoCAD LT in gebruik of werkwijze zal dit duidelijk wor-
den aangegeven.

Aanwijzingen voor het gebruik van dit boek

Dit boek is geschreven om u te helpen op uw eerste ontdekkingstocht door
AutoCAD. Aan de hand van een bondige en rijk geillustreerde uitleg maakt u
kennis met de verschillende mogelijkheden om een tekening op te zetten en
uiteindelijk af te drukken. Tussen deze twee punten zit echter een lang traject.
Met nadruk wijzen we u erop dat dit boek een basiscursus is. Dat houdt in dat
niet alle commando’s en ook niet altijd alle opties van een commando worden
behandeld. Dit is een bewuste keuze waarmee we willen voorkomen dat u het
spoor bijster raakt en mogelijk daarbij ook uw enthousiasme!

Elk hoofdstuk begint met een doelstelling. Dit is een korte inleiding in de stap-
pen die u dient te nemen om een bepaald eindresultaat te bereiken. Vervol-
gens zullen deze stappen een voor een met u worden doorgenomen, meestal
in de vorm van een oefening. Aan het eind van ieder hoofdstuk volgt een korte
samenvatting met een herhaling van de kernpunten.

Oefenen, oefenen, oefenen!

Op de websites van Academic Service (www.academicservice.nl) en de auteur
(www.caddesign.nl) staan alle oefeningen die in dit boek worden gebruikt. U
kunt deze oefeningen als zip-bestand downloaden. In dit bestand vindt u deze
oefeningen in tweevoud terug: eenmaal als uitgangspunt voor de oefening en
eenmaal als voltooide oefening. Kopieer deze oefeningen naar de harde schijf
van uw computer, zodat u ze eenvoudig kunt openen en bewerken.

Afspraken in dit boek
In AutoCAD kunt u op verschillende manieren een commando starten. De
meest voorkomende mogelijkheden zijn:

e Klik op de knop van een commando in de ribbon of werkbalken.

e Selecteer het commando uit de menubalk (Classic workspace).

e Typ het commando volledig in op de commandoregel of dynamic prompt.
¢ Gebruik een sneltoets of toetsencombinatie.
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Deze manieren zullen in het boek in de vorm van een tabel worden weerge-
geven:

T Ribbon: Home >Draw

|/ ‘ Menu: Draw >Line

— Intypen: Line (Enter)
Line Sneltoets: L (Enter)

Het is aan u welke methode u gebruikt. Kies de voor u prettigste methode!

Toetsen die u indrukt, worden in een vet lettertype weergegeven, bijvoorbeeld,
druk op de Enter-toets. Teksten en opdrachten die u moet invoeren, worden
eveneens vet weergegeven.

Let op dat alles wat u intypt bevestigd dient te worden met Enter!

De namen van menu’s, commando’s, dialoogvensters, werkbalken en knop-
pen worden in dit lettertype weergegeven. Bijvoorbeeld: kies in het menu File
het commando Open. Dit lettertype wordt ook gebruikt voor tekst die op het
scherm verschijnt.

De diverse hoofdstukken bevatten opmerkingen, tips en waarschuwingen.
Deze zijn achtereenvolgens aangeduid met de tekens:

Tot besluit

Net als met autorijden leert u pas echt goed tekenen met AutoCAD door het
veel te doen. Hoe vaker u een commando gebruikt, hoe eerder u toepassings-
mogelijkheden leert herkennen. Bekijk een tekening die u moet maken niet
alleen op techniek, maar probeer direct verbanden te herkennen waardoor u
steeds sneller in staat zult zijn een tekening op te zetten.

We houden ons aanbevolen voor opmerkingen, uitbreidingen en suggesties
die kunnen leiden tot verbetering van de inhoud bij volgende drukken. Uw
reacties kunt u e-mailen naar de auteur op harold@caddesign.nl.

Ik wil het redactieteam bedanken voor alle t-tjes, d-tjes, punten en komma’s
en het meedenken, en alle overige medewerkers van Academic Service voor de
prettige samenwerking!

Wilt u ook thuis kunnen oefenen? Op de website van Autodesk kunt u, na regis-
tratie, gratis de (30-dagen)trialversie van AutoCAD of AutoCAD LT downloa-
den. Ga hiervoor naar www.autodesk.nl of www.autodesk.com.
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Meer informatie over de auteur en eventuele AutoCAD-trainingen vindt u op:
www.caddesign.nl

Wij wensen u veel succes en vooral plezier bij het tekenen!

Sprang-Capelle, mei 2012
Harold Weistra



1.1

1.2

1.2.1

Starten met AutoCAD

In dit hoofdstuk maken we u wegwijs in de schermindeling van AutoCAD.
Eveneens leert u de basishandelingen die nodig zijn om AutoCAD te bedienen.

In dit hoofdstuk

— AutoCAD starten en afsluiten.

— Deverschillende delen van de gebruikersinterface benoemen en bedienen.
- Werken met muis en toetsenbord.

— Tekeningen openen, opslaan en sluiten.

- Commando’s starten en beéindigen.

- Helpfuncties binnen AutoCAD.

AutoCAD starten

U kunt AutoCAD onder andere op de volgende manieren starten:

e Viahetmenu Start.
¢ Viaeen snelkoppeling op het bureaublad.
¢ Door een tekening vanuit Windows Verkenner te openen.

AutoCAD starten via het menu Start

Via het menu Start van Windows zoekt u in de lijst Alle programma’s naar
de verzamelmap Autodesk. In deze map staan snelkoppelingen naar alle
AutoCAD-versies die op uw systeem zijn geinstalleerd. Ook vindt u hier enkele
hulpprogramma’s. Kies de submap AutoCAD (LT) 2013 en vervolgens het
programma AutoCAD (LT) 2013.



1.2.2

1.2.3
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AutoCAD starten met een snelkoppeling

Tijdens de installatie is er een snelkoppeling op het bureaublad geplaatst. U
start AutoCAD door hierop te dubbelklikken.

AutoCAD starten via Windows Verkenner

Zoek in Windows Verkenner de tekening die u wilt openen. Dubbelklik hierop
ofklik met de rechtermuisknop en kies Open.

Oefening 1.1 De schermindeling
1 Start AutoCAD met behulp van de snelkoppeling op het bureaublad.
2 AlsAutoCAD gestartis, ziet u het Welcome-scherm (zie figuur 1.1).

Autodesk

hange ppb i

Recent Files

Autodesk 360

Connect With AutoCAD

f »

Figuur 1.1

Dit Welcome-scherm is in drie delen opgesplitst. In het Work-gedeelte kunt
u snel een nieuwe tekening beginnen of een bestaande tekening openen. Ook
verschijnt er een lijst van meest recent gebruikte bestanden. In het Learn-
gedeelte vindt u de belangrijkste nieuwe functies in AutoCAD 2013. Mocht u al
bekend zijn met AutoCAD, dan is dit een goede manier om snel bijgespijkerd
te worden. In het Extend-gedeelte kunt u contact maken met AutoCAD 360,
uw Autodesk account’ in the cloud’, of de social media-pagina’s van Autodesk



1 « Starten met AutoCAD

1.3

bezoeken. U kunt ook apps downloaden bij de Autodesk Exchange Apps (niet
beschikbaar in AutoCAD LT).

3 Sluithetvenster door op het kruisje rechtsboven in de hoek te klikken.

De gebruikersinterface van AutoCAD

De gebruikersinterface van AutoCAD 2013 heeft dezelfde uitstraling gekregen
die u misschien herkent van Microsoft Office. De belangrijkste commando’s
zijn samengevat in de ribbon boven in het scherm.

[y =] ERTEIAE B0 ey Eim]

Figuur1.2
Om duidelijkere schermafbeeldingen te tonen wordt in dit boek zo veel moge-
lijk gebruikgemaakt van een egaal witte achtergrond.
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Deze gebruikersinterface is opgedeeld in een aantal hoofdonderdelen:

1.3.1 Titelbalk (title bar)

Helemaal bovenaan in het venster vindt u de titelbalk. Hierin staan in het mid-
den het versienummer van AutoCAD en de naam van de tekening waaraan u
werkt.

De titelbalk biedt verder plaats aan:

AutoCAD-menu

Links in de titelbalk vindt u het AutoCAD-menu (zie figuur 1.4). Dit menu
biedt snel toegang tot de meest voorkomende commando’s om bestanden te
openen, op te slaan of af te drukken.
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Quick Access-werkbalk

Naast het menu vindt u de Quick Access-werkbalk. Hierin staan de meest
voorkomende algemene commando’s zoals: Nieuw, Openen, Opslaan, Afdruk-
ken en Ongedaan maken.

Workspace

Als u al wat langer met AutoCAD werkt, krijgt u misschien de behoefte de ge-
bruikersinterface naar uw smaak en wensen aan te passen. Het is mogelijk zelf
onderdelen aan de interface toe te voegen of bestaande onderdelen te wijzi-
gen. Deze gewijzigde instellingen kunt u opslaan als een workspace.

Met behulp van workspaces is het mogelijk te kiezen tussen verschillende ge-
bruikersinterfaces die passen bij verschillende werkzaamheden. Zo zijn in
AutoCAD 2013 de volgende standaard-workspaces beschikbaar:

e Drafting & Annotation;

e 3D Basics (nietin AutoCAD LT);

e 3D Modeling (nietin AutoCAD LT);
e AutoCAD Classic.

De huidige schermindeling met de ribbon is opgeslagen in de Drafting & Anno-
tation workspace. De 3D-workspaces wijzigen de ribbon zodanig dat deze de
benodigde 3D-tabbladen en panelen bevat.
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Veel van de commando’s die u vanuit de ribbon kunt starten, vindt u ook terug
in de menubalk en werkbalken die rondom het tekenveld kunnen worden ge-
plaatst. Veel mensen zullen in figuur 1.5 AutoCAD herkennen zoals het tot ver-
sie 2009 bekend was. Dit is de workspace AutoCAD Classic.
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Figuur 1.5

In deze basiscursus wordt gebruikgemaakt van de standaard-workspace Draf-
ting & Annotation.

Zoekmenu

Rechts in de titelbalk vindt u het Search menu. Het Search menu is geopti-
maliseerd om hulp te zoeken in de helpbestanden of op internet. De resulta-
ten worden getoond in de Autodesk Exchange browser die u ook ziet wanneer
AutoCAD opstart.

Ribbon

De ribbon vervangt de vroegere werkbalken en menu’s. De belangrijkste Auto-
CAD-commando’s zijn gerangschikt in meerdere tabbladen en panelen. Ieder
paneel bevat de meest voor de hand liggende functies waarbij sommige pane-
len kunnen worden uitgeklapt om toegang te verkrijgen tot extra functies.
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Door op het kleine pijltje in het midden van de ribbon te klikken kunt u kiezen
uit verschillende weergavemogelijkheden. Dit alles om ruimte in het teken-
scherm te besparen.

Klikt u met de rechtermuisknop in de ribbon dan kunt u kiezen welke tab-
bladen en panelen getoond dienen te worden (zie figuur 1.6).
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U kunt er ook voor kiezen de ribbon zwevend als een palette op het scherm te
plaatsen (undock) zoals te zien in figuur 1.7.
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Eventueel kunt u de ribbon parkeren (anchor left/right) als een dashboard.
Een dashboard kan met de functie Auto-hide automatisch open- of dichtklap-
pen als u er met de muis bovenop staat of ervan af beweegt. Deze opties vindt u
door met de rechtermuisknop te klikken in de balk naast de ribbon.

Het is opnieuw mogelijk het scherm geheel naar eigen inzicht en behoefte in te
delen. U moet ermee werken en ernaar kijken dus maak het zo comfortabel en
vertrouwd mogelijk. Ook deze wijzigingen kunt u weer opnemen in een work-
space.

Ribbon bedienen

Wanneer u met de muis over de knoppen in de ribbon beweegt, verandert
de kleur zodat u duidelijk kunt zien welke knop u op het punt staat te kiezen.
Houdt u de muis stil boven een knop, dan worden de naam en een korte om-
schrijving van het commando getoond in een tooltip (figuur 1.8).
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Figuur 1.8

Houdt u de muis iets langer boven de knop, dan verandert de tooltip in een
Extended Tooltip (figuur 1.9). Hierin vindt u een uitgebreidere uitleg van het
commando plus vaak een voorbeeld van de tijdens het commando te volgen
stappen.
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Enkele knoppen hebben een klein driehoekje naast of onder de afbeelding (zie
figuur 1.10). Zodra u op dit driehoekje klikt, verschijnt er een zogenoemde fly-
out waaruit u variaties van het geselecteerde commando of soortgelijke com-
mando’s kunt kiezen. Op deze manier zijn snel meer commando’s te tonen zon-
der extra schermruimte in beslag te nemen.
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Verschillende panelen zijn ook nog eens uit te klappen door op het driehoekje
naast de paneelnaam te klikken. Hierin vindt u de minder vaak gebruikte com-
mando’s.

Wilt u niet dat een uitgeklapt paneel weer dichtklapt nadat u een commando
hebt gekozen, klik dan op de punaise links naast de paneelnaam. Hiermee prikt
uhet paneel vast op het scherm.
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Figuurl.11

Tot slot vindt u in verschillende panelen een schuin pijltje rechtsonder in de
hoek. Klikt u op dit pijltje dan opent een dialoogvenster waarin u verschillende
instellingen kunt doen of stijlen kunt aanmaken.

Deribbonis een intelligent ding. Bij verschillende commando’s zijn zo veel op-
ties en instellingen mogelijk dat de ribbon automatisch omschakelt naar een
bijbehorend tabblad dat normaal gesproken niet wordt getoond. Meer uitleg
hierover volgt bij deze commando’s.
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1.3.3 Tekenveld (Drawing Area)

Het overgrote deel van het venster wordt gebruikt voor het tekenveld. U mag dit
veld beschouwen als een oneindig groot vel transparant papier waarop u uw
tekening maakt. We noemen dit veld het Model. Op het moment dat u gaat af-
drukken kunt u gebruikmaken van Layouts. U vindt dit terug in de tabbladen
onder het tekenveld. Meer hierover in hoofdstuk 14 en 15.

1.3.4 Commandoregel (Command Line)

In het onderste deel van het venster vindt u de commandoregel. Zodra u een
opdracht geeft, vraagt AutoCAD u details om deze opdracht uit te voeren. U
bent dus voortdurend interactief met het programma bezig. Dit hele proces is
te volgen via de commandoregel.
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‘
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P specify mext point or [unda]: §0.100
specify mext point or [Close/Unda]: §-100,8
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Figuur1.12

De onderste regel van de commandoregel is het actieve gedeelte. Hier typt u
commando’s, opties of gegevens in. Zodra u begint te typen vult auto-complete
de mogelijkheden voor u aan.

De bovenste regels geven de commandogeschiedenis of de instellingen van de
geactiveerde commando’s aan. De commandoregel kan vrijstaand boven het
tekenscherm zweven of worden verankerd bovenop de statusbalk. In figuur
1.12 ziet u beide mogelijkheden. U kunt dit eenvoudig bereiken door op de
grips te klikken en te slepen (zie pijlen).

1.3.5 Dynamic Input

AutoCAD heeft sinds versie 2006 de functie Dynamic Input. Deze functie laat
de vraagstelling uit de commandoregels of de opties uit het snelmenu (rechter-
muisknop) naast de kruisdraad zien. We noemen dit de Dynamic Prompt (zie
figuur 1.13). Het grootste voordeel van deze functie is dat tijdens het tekenen
ook afmetingen direct worden weergegeven. Het werken met AutoCAD is hier-
door veel intuitiever geworden doordat u zich concentreert op het tekenveld
zonder telkens naar de commandoregel te hoeven kijken. Deze optie is helaas
niet in het gehele programma doorgevoerd, dus op sommige momenten is de
commandoregel nog onmisbaar. Bent u eenmaal gewend aan Dynamic Input,



1 « Starten met AutoCAD

1.3.6

dan hoeft u de commandoregel nagenoeg niet meer te gebruiken en kunt u
deze verbergen.

Bij Dynamic Input voert u maten in in de daarvoor bestemde velden. Opties
binnen commando’s kunt u kiezen door op | op uw toetsenbord te drukken.

Figuur1.13

In deze basiscursus zal zo veel mogelijk gebruikgemaakt worden van de nieuw-
ste mogelijkheden van AutoCAD, dus ook van Dynamic Input. Daar waar
nodig zal expliciet naar de commandoregel worden verwezen. Om de leesbaar-
heid te vergroten, zien de afbeeldingen van Dynamic Input in dit boek er iets
anders uit dan bij u op het scherm.

Statusbalk (Status Bar)

De statusbalk bevat onder andere een groot aantal hulpmiddelen die het teke-
nen vereenvoudigen. Daarnaast kunt u codérdinaten uitlezen en verschillende
instellingen wijzigen (zie figuur 1.14).
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Figuur1.14

Deze hulpmiddelen kunt u te allen tijde naar wens in- of uitschakelen. Dit doet
u door met de linkermuisknop op de knoppen te klikken. Een grijze knop staat
uit, een blauwe staat aan. De namen van de hulpmiddelen worden getoond in
een tooltip die verschijnt als u uw muis stilhoudt boven een knop.

Naam hulpmiddel Functie

Infer Constraints* Automatisch constraints toevoegen.

Snap Mode Volgt hetingestelde lijnraster (zie Grid).

Grid Display Toont lijnraster in het tekenveld.

Ortho Mode Beperkt de vrijheidsgraden tot hoeken van 90 graden.

Tabel 1.1: Hulpmiddelen in de statusbalk -

15
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Naam hulpmiddel Functie

Polar Tracking Beperkt de vrijheidsgraden tot de gekozen hoeken.
Object Snap Activeert vangfuncties bij puntselectie.
3D Object Snap* Activeert vangfuncties bij 3D-puntselectie.

Object Snap Tracking  Geeft virtuele hulplijnen weer.
Allow Dynamic USC*  Automatische tekenvlakkeuze bij 3D-tekenen.
Dynamic Input Toont input naast kruisdraad.

Show/Hide Lineweight Toontlijndiktes op het tekenveld.

Show/Hide Trans- Activeert transparantie van lagen of arceringen.
parency

Quick Properties Toont Quick Properties-paneel op het scherm.
Selection Cycling Hulpmiddel bij selecteren van overlappende objecten.

Annotation Monitor Controleert de koppeling van associatieve objecten

Tabel 1.1 (vervolg): Hulpmiddelen in de statusbalk

Hulpmiddelen gemarkeerd met * zijn niet beschikbaar in AutoCAD LT en wor-
den niet behandeld in deze cursus.

Commando’s geven, afbreken en herhalen

Soms ontstaat er wat verwarring door de vele manieren waarop het moge-
lijk is een commando te geven. Sommige commando’s kunnen op wel vier of
vijf manieren worden geactiveerd. Er is daarbij geen goede of slechte manier.
U kiest de manier die u het beste past. Hiervoor zullen wij bij ieder commando
aangeven welke mogelijkheden u hebt.

De meest voorkomende mogelijkheden zijn:

e Klik op de knop van een commando in de ribbon of de werkbalken.

¢ Selecteer het commando uit het betreffende menu (AutoCAD Classic Work-
space)

e Typ het commando volledig in op de commandoregel of in de dynamic
promptnaast de muis.

¢ Gebruik een sneltoets of toetsencombinatie.

Als voorbeeld het commando Open waarmee u tekeningen opent. De volgen-
de tabel toont de verschillende manieren waarop u het commando kunt star-
ten. Kies zelf de prettigste manier van werken.

T Ribbon: Quick Access-werkbalk
‘E ‘ Menu: File > Open...

— Commandoregel: | Open

Open Sneltoets: Ctrl+O
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Een volgend punt voor verwarring is het beéindigen van commando’s. Sommi-
ge moeten worden beéindigd door op Enter te drukken, terwijl andere na het
uitvoeren van een taak zichzelf beéindigen. Het verschil zit hem hierin:

¢ Als een handeling slechts eenmaal uitgevoerd kan worden, beéindigt het
commando zichzelf en hoeft u niet meer op Enter te drukken.

¢ Als u een handeling binnen een commando meerdere malen kunt uitvoe-
ren, dient u het commando zelf met Enter te beéindigen.

Een goed voorbeeld hiervan zijn de commando’s Move (verplaatsen) en Copy
(kopiéren). Verplaatst u een object, dan wordt het commando beéindigd nadat
u het object hebt verplaatst. U kunt dus maar één keer verplaatsen. Kopieert u
een object, dan kunt u meer dan één kopie maken. Om aan te geven dat u klaar
bent met kopiéren, beéindigt u het commando door op Enter te drukken nadat
u de laatste kopie hebt geplaatst.

Blijfhet verloop van het commando altijd volgen in de Dynamic Prompt of op
de commandoregel. Hieruit zal altijd blijken of het commando nog actief is
of niet. Zodra de Dynamic Prompt verdwijnt en in de commandoregel weer
Command: staat, wacht AutoCAD op een nieuwe opdracht en is het actieve
commando beéindigd.

In plaats van de Enter-toets mag u ook de rechtermuisknop of spatiebalk
gebruiken om een commando te beéindigen.

Soms start u een commando en merkt u dat u het verkeerde commando hebt
gekozen of dat u eerst nog iets anders wilt doen. Druk maximaal driemaal op de
Esc-toets op het toetsenbord om alles te annuleren.

Wilt u het laatst gegeven commando herhalen, druk dan op de Enter-toets of de
spatiebalk en het laatste commando wordt direct weer geactiveerd.

Opties tijdens commando's

Bij veel commando’s kunt u tijdens het uitvoeren van het commando voor extra
opties kiezen. Vaak zijn dit sub-commando’s, binnen het gekozen commando,
die u kunt uitvoeren zonder het gekozen commando te beéindigen.

De opties zijn meestal op drie manieren te kiezen. Zie figuur 1.15 voor de opties
tijdens het commando Line (deze zijn in 1 afbeelding gemonteerd om u de ver-
schillen te laten zien).

1 Lees de commandoregel. Hierop staan de opties tussen haken en met een
achtergrondkleur aangegeven [Optie]. Meestal staat de eerste letter van
die optie als hoofdletter aangegeven en heeft deze een kleurtje. Typ deze
letter(s) in en bevestig de invoer met Enter, of klik met de muis op het gear-
ceerde gedeelte, om de optie te kiezen.
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2 Klik op de rechtermuisknop. De opties worden in een schermmenu ge-
toond waar u deze kunt selecteren om de optie te kiezen. Behalve de actuele
opties toont dit menu ook nog een aantal algemene opties of hulpmidde-
len.

Enter
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Close %
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Figuur1.15

3 Als Dynamic Input staat ingeschakeld, kunt u op het pijltje naar beneden
van uw toetsenbord drukken. Onder de Dynamic Prompt worden dan de
beschikbare opties getoond. Deze kiest u door de gewenste optie met de
muis aan te klikken.

Muisknoppen en muiswiel

Het tekenen met AutoCAD gebeurt voor het grootste deel met de muis. In deze
basiscursus wordt uitgegaan van het werken met een muis met een muiswiel
en twee knoppen. Hebt u geen muis met een muiswiel, schaf deze dan zo snel
mogelijk aan. Het wieltje levert u veel gemak en tijdwinst op.

Waarschijnlijk is het u al opgevallen dat de muisaanwijzer in het venster er an-
ders uitziet dan u gewend bent van de meeste Windows-programma’s. In Auto-
CAD wordt de muisaanwijzer gevormd door een horizontale en verticale lijn
met in het midden een klein blokje. We noemen deze aanwijzer de kruisdraad
(cross-hair). Net als het symbool linksonder in de hoek van het tekenveld, het
UCS-icon, refereert de kruisdraad aan de assen waarmee AutoCAD punten in
de tekening vastlegt. Dit wordt uitvoerig behandeld in hoofdstuk 6.

De linkermuisknop dient voor het selecteren van menu’s en knoppen in de
werkbalken, en voor het aanwijzen van punten in het venster. Deze knop wordt
ook gebruikt om bestaande elementen te selecteren om deze te kunnen bewer-
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ken. Zodra u met de kruisdraad het tekenveld verlaat, verandert deze in een
pijltje.

De rechtermuisknop werkt net als de spatiebalk als een alternatief voor de
Enter-toets. Er is nu echter wel een verschil. Standaard staat de rechtermuis-
knop intelligent ingesteld. Een klik op de rechtermuisknop zal athankelijk van
waar en wanneer u klikt een andere functie hebben. Figuur 1.16 geeft daarvan
een aantal voorbeelden.

¢ Als er geen commando actief is en u klikt met de rechtermuisknop in het
tekenveld, zal een snelmenu worden getoond. Boven in dit snelmenu staat
altijd Repeat... (+ laatste commando). Daaronder staan enkele opties die u
op dat moment hebt.

Repeat LINE v Cursor Coordinate Values Recent Commands 3 LINE
Recent Input % 3 Status Toggles T} 3 T UNITS
Cliphoard 4 v Paper/Model Copy History OPTIONS
Isolate N v Quick View Layouts Paste "NAVVCUBEDISPLAY
¥ Quick View Drawings Paste To CmdLine SRR
€| Undo Line v Annotation Scale 5 (LAl
o e v Annotation Visibility et [
S ey v | AutoScale
c%' Zoom v Workspaces
@ SteeringWheels || Display Locking
Action Recorder » v Display Performance
Subobject Selection Filter 3 )| S
[[¥ Quick Select... Drawing Status Bar
E  QuickCalc Tray Settings...
@2 Find...
[ Options...
Figuur1.16

¢ Veel commando’s hebben extra opties. Klikt u met de rechtermuisknop tij-
dens een dergelijk commando, dan zal het snelmenu deze opties tonen.

¢ Alsuvoor een commando een selectie hebt gemaakt, dient u AutoCAD aan
te geven wanneer u klaar bent met selecteren. Klikt u na het maken van de
selectie met de rechtermuisknop, dan zal AutoCAD verdergaan met de vol-
gende stap van het commando. U bevestigt dus de selectie.

¢ Hebt u een selectie gemaakt zonder eerst een commando te activeren en
klikt u vervolgens met de rechtermuisknop, dan toont het snelmenu een
aantal bewerkingen die u direct op de selectie kunt toepassen.

U merkt het, er zijn een groot aantal, soms verwarrende, mogelijkheden. Neem
bij de eerste oefeningen ruim de tijd om de verschillende menu’s te bestude-
ren. Door goed gebruik te maken van deze menu’s kunt u zich veel extra hande-
lingen besparen.

Het muiswiel gebruikt u om snel in de tekening te zoomen en te pannen. Door
te zoomen kunt u details uitvergroten of juist de hele tekening in het venster
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tonen. Door te pannen verschuift u de hele tekening onder uw venster door. U
maakt dan andere delen van de tekening zichtbaar zonder te hoeven zoomen.
Deze functies worden in hoofdstuk 3 uitgebreid besproken.

Commando's ongedaan maken

Fouten maken is menselijk en helaas gebeurt dat tijdens het tekenen regel-
matig. Wees echter vooral niet bang om fouten te maken. Blijf niet te lang twij-
felen of piekeren als u niet zeker weet of u een commando juist uitvoert. Bent
ubang dat u niet het juiste commando hebt gekozen, probeer het dan gewoon.
Het voordeel van een computer is dat we met één druk op de knop een actie
weer ongedaan kunnen maken. Dus geen gedoe meer met gum of radeermes;je.

Undo: het voorgaande commando ongedaan maken

Als een handeling al is uitgevoerd, kunt u het commando Undo gebruiken om
deze handeling weer ongedaan te maken. Dat kan van alles zijn, bijvoorbeeld
een lijn tekenen, een lijn verplaatsen of een zoomactie uitvoeren.

De functie Undo kan bij een aantal commando’s ook tijdens het commando
gebruikt worden. Kijk in de opties binnen het commando of type de letter U
gevolgd door Enter.

I Ribbon: Quick Access-werkbalk
‘@ H Menu: Edit > Undo
— Commandoregel: | Undo

Undo Sneltoets: U of Ctrl+Z

Redo: Undo-commando’s weer ongedaan maken

Met het commando Redo kunt u handelingen weer terughalen die daarvoor
met Undo-acties ongedaan gemaakt zijn. De ongedaan gemaakte handelingen
worden dan weer hersteld. Ook de knop van dit commando staat in de Quick
Access-werkbalk.

B Ribbon: Quick Access-werkbalk
‘ [r_‘:> Menu: Edit > Redo

I Commandoregel: | Redo

Redo Sneltoets: Ctrl+Y

- ‘
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1.5

Het commando Oops

De laatste Erase-actie maakt u ongedaan met het commando Oops. Wat u het
laatst hebt verwijderd uit de tekening, wordt dan weer teruggeplaatst. Het doet
er niet toe of u na deze Erase-opdracht andere commando’s hebt gebruikt of
uitgevoerd. Het commando Oops moet u intypen, er is geen knop of menu-
keuze voor.

Helpfuncties binnen AutoCAD

Raakt u toch nog de weg kwijt binnen AutoCAD? Geen paniek! De helpfuncties
van AutoCAD zijn zeer uitgebreid. Kreeg u vroeger nog drie dikke boeken bij de
software, tegenwoordig zijn die helemaal verwerkt in de helpfuncties. U kunt
de boeken overigens nog wel aanvragen bij Autodesk.

De eenvoudigste manier om hulp bij een commando te krijgen is door gebruik
te maken van functietoets F1.

Oefening 1.2 Helpfuncties voor het commando Line
1 Starthetcommando Line.

A Ribbon: Home > Draw
‘I/ ‘ Menu: Draw >Line
— Commandoregel: | Line

Line Sneltoets: L

2 Drukop functietoets F1.

Het scherm Autodesk Exchange wordt geopend en brengt u naar de juiste
helppagina voor het lijncommando. Hier kunt u lezen hoe u het commando
geeft en wat de te volgen stappen zijn om het commando te voltooien. Zie
figuur 1.17.

3 Sluithet helpvenster.
4 Annuleer hetlijncommando door op Esc te drukken.
5 Sluitde tekening.
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Creates straight line segments.

Access Methods

7

Button

R Ribbon: Home tab > Draw panel > Line

8 Menu: Draw > Line

8 Toolbar: Draw

Summary

With LINE. you can create a series of contiguous line segments. Each segment is a line object that can be edited separataly.

2
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Figuur1.17

1.6

Samenvatting

De eerste kennismaking met AutoCAD zit erop. Er zullen nog veel nieuwe com-
mando’s en bijbehorende oefeningen volgen. In ieder geval weet u nu waar u
het een en ander kunt vinden. De belangrijkste punten van dit hoofdstuk:

e Het herkennen van de verschillende onderdelen van de AutoCAD-scherm-

indeling.

e Commando’s geven.

Commando’s afbreken met Esc.

Handelingen ongedaan maken met Undo.

AutoCAD-commando’s zijn op verschillende manieren te herhalen: met
een druk op de Enter-toets, de spatiebalk of via een snelmenu dat u via een
klik met de rechtermuisknop oproept.

Op de commandoregel of in de Dynamic Input-velden verschijnen op-
drachten of vragen om de commando’s te kunnen voltooien.

Druk op functietoets F1 om direct de helppagina’s van het commando waar
umee bezig bent op te roepen.
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Symbolen
[...] 76
@ 83
# 83
A
afdrukken

afdruk centreren 283

afdrukschaal 278

arceringen 278

lijntype 278

line type scale 278

maatinstellingen 278

model 279

opties 285

oriéntatie 283

papierformaat 281

papiermarges 278

PDF 280

plot style table 285

preview 282, 284

printer selecteren 280

schaal instellen 282

selectie 281

teksthoogte 278
afdrukvoorbeeld 298
afronding 169

multiple 169

opties 169

polyline 169

radius 169

trim 169

undo 169
afschuining 171

angle 172

distance 172

method 172

multiple 172
opties 172
polyline 172
trim 172
undo 172

arcering 221

afdrukschaal 232
annotative 231

associative 231
automatisch aanpassen 232
begrenzing 227

begrenzing opnieuw tekenen 227

boundary 221

gekleurde vlakvulling 229
hoek 227

instellingen kopiéren 232
island detection 232
kleurverloop 222

losse vlakken 232
patroon 222

predefined 227

preview 227

schaal 225, 227

select objects 227
spacing 228

user defined patroon 227
weergave volgorde 232
wijzigen 229

arceringen

annotatief 279

assenstelsel 67

UCS-icoon 68
X-as 68
Y-as 68
Z-as 68

associative 231
AutoCAD

opties 322

AutoCAD menu 8



back-up 27
BAK 23
bestand
back-up 23
meerdere tegelijk openen 304
nieuw 23
openen 25
opslaan 27
opslaan als 28
sjabloon 24
bestandstype 29
backwards compatible 29
BAK 23
DWG 23, 29
DWT 24
DXF 29

verschillende AutoCAD-versies 30

bibliotheek 317
blauwe blokjes 185
blokken 308
annotatief 310
automatisch verschalen 317
definitie 309
en lagen 315
invoegen 313
maken 308
referentiepunt 309
roteren 314
verschalen 314
boog 114
3 points 115
center, start, angle 115
center, start, end 115
center, start, length 115
continue 115
start, center, angle 115
start, center, end 115
start, center, length 115
start, end, angle 115
start, end, direction 115
start, end, radius 115
boundary 232

C
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opties 110

tan, tan, tan 110
color 201

color books 229

index color 229

true color 229
commando

activeren 16

afbreken 17

beéindigen 17

geven 16

herhalen 17

ongedaan maken 20
commandoregel 14
constructielijn 153

ang 154

bisect 154

hor 154

offset 154

opties 154

ver 154
coordinaat

absolute nulpunt 67

absoluut 67

nulpunt 67

polair 77

relatief 73
coordinaten

UCS-icon 18
copy 303

D

Center-markering 259
cirkel 109
2 points (2P) 110
center diameter 110
center radius 110

direct distance entry 84

drafting settings 56
object snap 56
polar tracking 87

DWF 290

DWT 24

dynamic input 14, 81
dimension input 82
dynamic prompt 14, 82
maten invoeren 15
opties kiezen 14
pointer input 82

eenheden 65
angle 66
inch 65
insertion scale 67
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length 66

lightning 67

millimeters 65

precision 66

sample output 67
eigenschappen

ByLayer 209

kopiéren 216
eigenschappen palette 213

gegevens controleren 213

gegevens uitlezen 213

objecteigenschappen aanpassen 213

verkleind 215
ellips 112
arc 112
center 112
opties 112
Enter 17
evenwijdige kopie 176
erase 176
exit 176
layer 176
opties 176
through 176
undo 176
exploderen 150
extension 90

G

gebruikersinterface 7
gegevens uitwisselen
AutoCAD 304
copy with basepoint 304
knippen 303
kopiéren 303
paste as block 304
paste to original coordinates 304
plakken 303
gesloten polylijn 232
GRID 98
grip 50, 185
blauw 185
groen 185
rood 185
groen blokje 185

Hatch angle
arcering\
hoek 225

Hatch color
arcering\
kleur 224
Hatch creation
arcering\
ribbon 222
Hatch pattern scale
arcering\
schaal 225
help 21
hulplijn 181

Inquiry 101
inzoomen 32

kleuren 201
knippen 138
crossing 138
edge 138
erase 138
fence 138
opties 138
shift 139
undo 138
komma 83
kopiéren 121
array 121
multiple mode 121
opties 121
single mode 121
kruisdraad 18

lagen 187
aan 193
aanzetten 193
activeren 202
afdrukken 203
bevroren 193
ByLayer 209
color 201
defpoints 192
eigenschappen aanpassen 200
evalueren 203
hulpmiddelen 214
kleur 193, 203
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kleur instellen 204
lijndikte instellen 208
lijntype instellen 206
linetype 201
lineweight 201
maken 202, 205
ontdooid 193
open 193
op slot 193
paneel 191
regenereren 194
symbolen 192
uit 193
verwijderen 202
lagen palette 201
layout 287
aanmaken 289
afdrukken 289, 299
indelen met viewports 290
kader 294
kopiéren 301
Page Setup Manager 290
paper mode 290
verschillende aanmaken 301
verwijderen 301
viewport 290
viewport aanmaken 294
viewport aanpassen 297
viewport beveiligen 297
viewport instellen 294
viewport openen 297
viewportschaal 296
viewportschaal instellen 294
viewport verbergen 298
viewport zoomen 297
lijn 69, 103
close 76, 104
opties 76, 104
undo 76, 104
lijndikte 218
lijnsoort 218
lijntypebibliotheek 206
lijntype schaal 218
linetype 201
lineweight 201

maatlijnen 251
associatief 260
automatisch aanpassen 261
basismaat 256
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beginpunt 254
diameter 257
extentielijn 254
hoekmeting 258
kettingmaat 256
lijn naar tekening 254
lineair 253
plaatsen 253
posities bewerken 260
positioneren 261
radius 257
stijl 264
tekst positie 262
uitgelijnd 258
maatlijnstijl 264
activeren 269
Alternate Units 267
annotatief 267
booglengte 265
center markeringen 265
eenheden 267
Fit 267
inches 267
lijnen instellen 265
lines 265
millimeters 267
pijlpunten 265
Primary Units 267
symbolen en pijlpunten 265
tekstplaatsing 266
tekststijl 266
Text 266
Tolerances 268
toleranties 268
verschaling 267
maten controleren 100
met distance 101
met dynamic input 100
meten 100
distance 101
move
basepoint 118
muis 16
knoppen 18
linkermuisknop 18
rechtermuisknop 19
snelmenu 19
wiel 18
muiswiel 31
pan 31
zoom 31
zoom extents 33
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multileader
block 273
tekst 273
multileaderstijl 271
content 273
Leader Format 272
structure 272

Navigation Bar 36

(0)

object
eigenschappen 211
eigenschappen aanpassen 211
eigenschappen palette 213
eigenschappen wijzigen 211
van laag wisselen 198
object snap 53
eenmalig 61
permanent 55
snap overrides 61, 63
snelmenu 63
tracking 90
werkbalk 62
Object Snaps
Apparent Intersection 62
Center 62
Endpoint 62
Extension 62
From 62
Insert 63
Intersection 62
Midpoint 62
Nearest 63
Node 63
None 63
Osnap Settings 63
Parrallel 62
Perpendicular 62
Quadrant 62
Tangent 62
Temporary Track Point 62
oops 21
opslaan 27
opslaan als 28
ortho 84
90 graden 84

page setup
aanmaken 289
pan 31,33
pan realtime 37
paste 303
patroonkopie 162
pad 167
rechthoekig 165
rond 162
Pattern
arcering\
patroon 223
PDF 280
pickbox 44
Pick points
arcering\
pick points 223
pijlen 270
POLAR 86
autotrack-vector 87
increment angle 87
tekenhoeken 86
polylijn 147,232
arc 148
close 148
exploderen 150
gesloten polylijn 148
maken 152
opties 148
tekenen 148
undo 148
polyline 105
pos-nummers 270
Properties
arcering\
eigenschappen 223

Q

quick access werkbalk 9

R

rechthoek 107
area 107
chamfer 107
dimensions 107
elevation 107
fillet 107
opties 107
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rotation 107 T
thickness 107
width 107 tabel 243 .
rekken 181 aantal kolommen instellen 247
ribbon aantal rijen instellen 247
automatisch aanpassen 13 .celst1]1 246, 247
dashboard 12 invoegen 247
fly-out 13 kolombreedte instellen 247
knoppen 13 maken 244
panelen 10 rijhoogte instellen 247
punaise 13 StlJl. 245
tabbladen 10 tekening

zwevend 11 afdrukken 279
rollover tooltip 199 gegevens uitwisselen 303

rood blokje 185 opschonen 321
roteren 124 structuur aanbrengen 187

copy 124 tekenveld 14

opties 124 tekst 235

reference 124 alinea 240
korte tekst 239

multi line 240
S ribbon 241
single line 239
wijzigen 242

samenvoegen 136

search menu 10 teksthoogte 238
Select Boundary Objects tekststijl 235
arcering\ dialoogvenster 236
select objects 223 effecten 238
selecteren instellen 236
all 50

lettergrootte 235

crossing window 47 lettertype 235

cyf:le 50 tekstverwerker 240

grips 50 template

las.t 49 opslaan als template 320, 321, 322
objecten 43 titelbalk 8

object uit selectie verwijderen 45 toetsenbord 16

previous 49 tooltip 12

remove 46 ) tooltip extended 12

selection preview 44 transparency

select objects 46 arcering\

speciale selectiemethoden 49

visuele hulpmiddelen 44

window 46
selectiemethoden 43 U

selection cycling -
selecteren 48 UCS-icoon 290

shift 51 uitzoomen 32
sjabloon 319
slotje 198
SNAP 98
spiegelen 130
spiegellijn 134
statusbalk 15

transparantie 225
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\" W
veelhoek 157 werkbalken 10
circumscribed 158 workspace 9
edge 158 3D basics 9
inscribed in circle 158 3D modelling 9
opties 158 AutoCAD Classic 10

verlengen 138
crossing 138
edge 138
fence 138
opties 138
shift 139
undo 138

verplaatsen 117

verschalen 126
copy 126
opties 126
reference 126
schaalfactor bepalen 126

verwijderen 44, 50

ViewCube 35

Drafting & Annotation 9

4

zoom 31
regenereren 34
zoom all 39, 41
zoom extents 38, 41
zoom in 40
zoom object 40
zoom out 40
zoom previous 38, 39
zoom realtime 39
zoom window 38, 39
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